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1. INTRODUCTION AND SCOPE OF THE DOCUMENT

This document serves as a manual describing use of AtenaWin working environment, from
which any ATENA FEM analysis can be prepared, executed and postprocessed. The
execution kernel ATENA is a general-purpose finite element code with many special features
for non-linear analysis of plain and reinforced concrete structures.

AtenaWin is a semi-graphical multi-document user interface (MDI). It can show and edit the
following types of windows:

All input and output streams involved in ATENA execution. These are typically:

o input file containing specification of input commands that describes a problem
to be analyzed. The available input commands are documented in ATENA
Program Documentation, Part 6, ATENA Input File Format. This file has
default filename extension *.inp and is marked as Window A in the figure
below.

o output file containing results from the current analysis. It has default extension
*.out and is indicated as Window B in the figure below. The file is updated
already during the exection.

o message file, which includes important messages from ATENA kernel sent
during the analysis. It has default extension *.msg, see the Window C in the
figure below.

o error file, which includes warnings and messages from ATENA kernel sent
during the analysis, see Window D in the figure below. The messages are
added by an exact location, where they are issued from. It has default
extension *.err.

Windows with graphical representation of momentary results from the current analysis
(for postprocessing). For example, such a window can present actual crack
development in an analyzed structure. The Window E in the figure below is another
example of such a window that plots distribution of structural strains ¢_.

Windows with 2D plots akin structural load-displacement (LD) diagrams, see the
Window F below. This type of windows is used to assess development of virtually any
output results in form of 2D plot. Such results can be for example maximum crack
width in the structure plotted against deformation at a particular point of the structure.
Note that the plotted data can with or without respect to time. Hence, AtenaWin can
produce plots akin history charts as well as for example output entity versus location
at a particulat time.

AtenaWin can also show Windows with a rich text, a hypertext HTML document, a
DHTML document or a document created by Microsoft Word, Microsoft Excel and
other Active Document based servers. This window is primarily intended for showing
AtenaWin online documentation (*.html, *.pdf files). The window has basically the
same functionality as MS Windows Explorer and it borrows most of its functionality
from it. Hence, this window is not available on system without MS explorer. In the
same way, visualization of a *.doc file needs MS Word being installed, a *.pdf file
needs Adobe Acrobat Reader installed etc.
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Figure 1 Typical windows during AtenaWin execution

One of important feature of AtenaWin is that its windows are updated at run time, i.c.
during the analysis. AtenaWin serves as a tool for convenient and accurate control of an

ATENA analysis of any type. You can open as many windows as needed.

The other important feature is that AtenaWin environment is fully functional during the
analysis, so that it is perfectly possible to add a new window or modify an existing window

while AtenaWin analysis is still in progress.

A significant advantage of AtenaWin against other pre and postprocessor is that it can
communicate with ATENA kernel at low level, so that any new feature recently

implemented in ATENA kernel is immediately available also in AtenaWin.



2. PROGRAM EXECUTION

There are several methods how to execute an ATENA FEM execution module, e.g. the
module CCStructures for nonlinear analysis of structures. One of them is to execute
AtenaWin environment using the command line that follows:

%AtenaWin% [/D path] [/M module _name] [/O] [input file] [output file] [message file]
[error_file] [/reset_desktop] [/translate ids] [ /extend int output width]
[/fextend real output width] [/catch fp instructs] [/demo_mode] [/silent]
[/batch_execute] [/execute] [/rtf] [/inbuf size=i] [/outbuf size=j] [/{demo_mod]
[/num_threads=n] [/num_iters per thread=m] [/num_ unused threads=m]

The above command launches AtenaWin as a 32-bit application. For 64bit version of
AtenaWin the command name should be %AtenaWin64%. Please note that the percent
symbol '%' is part of the command and should not be forgotten.

The description of individual AtenaWin parameters is described below. In order to simplify
the execution of AtenaWin for individual module types, i.e. statics, dynamics, etc, the
following environmental variables were created during the software installation for easier
execution:

Table 1 Environmental variables for AtenaWin and AtenaConsole’ execution

Command

AtenaWin 32-bit execution

%AtenaWin% Basic AtenaWin command, by default executes statics
module

%AtenaWinD% AtenaWin execution for dynamics analysis

%AtenaWinC% AtenaWin execution for Creep analysis

%AtenaWinT% AtenaWin execution for Transport analysis

AtenaWin 64-bit execution

%AtenaWin64% Basic AtenaWin command for 64-bit execution, by
default executes statics analysis

%AtenaWinD64% AtenaWin 64-bit execution for dynamics analysis

%AtenaWinC64% AtenaWin 64-bit execution for creep analysis

%AtenaWinT64% AtenaWin 64-bit execution for transport analysis

AtenaConsole 32-bit execution

%AtenaConsole% Basic AtenaConsole command, by default executes
statics module

%AtenaConsoleD% AtenaConsole execution for dynamics analysis

%AtenaConsoleC% AtenaConsole execution for creep analysis

' AtenaConsole allows the execution of ATENA analysis in a command window, when no graphical output
during the analysis is available.




%AtenaConsoleT% AtenaConsole execution for transport analysis

AtenaConsole 64-bit execution

%AtenaConsole64% Basic AtenaConsole 64-bit execution, by default
executes statics module

%AtenaConsoleD64% AtenaConsole 64-bit execution for dynamics analysis

%AtenaConsoleC64% AtenaConsole 64-bit execution for creep analysis

%AtenaConsoleT64% AtenaConsole 64-bit execution for transport analysis

The above table includes also the environmental variables for launching ATENA as a
command line process, when no graphical output is available during the analysis, but it results
usually in faster execution times.

A typical use of AtenaWin is to issue one of the above commands. Then, within AtenaWin
input file window, all input commands are written. It follows execution of the problem, see
the menu Application or icons for Execution controls and problem postprocessing.

ATENA works with four analysis streams. These are:

e Input stream. It includes input commands describing an analysed problem . The
commands and their syntax are described in separate document ATENA Program
Documentation, Part 6, ATENA Input File Format. As an example of such a file see
Window A from Figure 1

e Output stream. It comprises all output data from the analysis, as requested by
OUTPUT commands. As an example of such a file see Window B from Figure 1.

e Message stream. The stream brings all vital information from the analysis. It can be
understood as a sort of journal file from the execution. As an example of such a file
see Window C from Figure 1.

e FError stream. This stream is similar to the above message stream, however, the
information is more detailed and it includes also some less severe warning and
comments from the analysis. As an example of such a file see Window D from Figure
1 Figure 1.

In the description of the command line the following notation was used:

/D path = specifies path to a default working directory, where input and output files
(corresponding to the above streams) should be stored.

/M module name = name of a main DLL library used for execution. By default, it is assumed
CCStructures. The CCStructuresCreep DLL is needed for creep analysis.

/O = specifies “overwrite” flag for output file, message file and error file files. This means
that during execution, or re-execution (see below) ATENA main execution files are created or
overwritten. By default the files are assumed to work in “append” mode, i.e. output of a new
analysis is added at the end of the appropriate files.

input_file = name of a file with ATENA input commands. If not specified, “Atena.inp” is
assumed.
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output_file = name of a file for ATENA output. If output file doesn’t exits, it is created.
Otherwise it is appended. If output file is not specified in the command line, then “Atena.out”
is assumed.

message_file = name of a file for ATENA message output. The message file contains compact
information on ATENA execution as for instance log of the execution start and end,
convergence performances, severe warning and error messages during execution etc. If
message_file doesn’t exits, it is created. Otherwise it is appended. If message file is not
specified in the command line, then “Atena.msg” is assumed.

error_file = name of a file for ATENA error output. The error file contains full information
on ATENA execution as for instance: a log of the execution start and end, convergence
performances, all warning and error messages during execution (incl. their place of
invocation) etc. If error_file doesn’t exits, it is created. Otherwise it is appended. If error file
is not specified in the command line, then “Atena.err” is assumed.

[/reset_desktop = use this option, if in an unlikely situation (like a previous system cash)
AtenaWin desktop needs reset.

[/translate _ids] = this option is only for internal use for debugging. Don’t use it.

[ /extend int output width] [/extend real output width] = double number of digits used to
output integer or real numbers, respectively.

[/catch_fp instructs] = flag to catch, (i.e. unmask) floating point exceptions during the
execution. Upon occurance of such exception it will get caught, reported and the
execution will be terminated. By default, foating point exceptions are ignored.

[/demo-mode] = flag for trial execution. All features are available in trial mode, hovewer,
there apply some restrictions towards size of trhe analyzed problem.

[/silent] = flag that forces AtenaWin to output eventual error messages into message_file and
error_file. By default, they are output to a message box on the screen. Use this
option for batch execution.

[/batch_execute] = option which forces AtenaWin automatically execute the given problem
without any user intervention. After the execution all output data are saved and
AtenaWin gets terminated. Use this option for batch execution.

[/execute] = option which forces AtenaWin automatically execute the given problem without
any user intervention. After the execution the AtenaWin session remains running,
thereby enabling a subsequent interactive postprocessing.

[/rtf]=flag for specifying rich-text format of all input/output files. By default this flag is not
set and consequently any ATENA input/output file can consists only of
alphanumerical data. As a result, the files are small and can be viewed and edited by
any editor like MS Notepad etc. If this flag is specified, AtenaWin will expect rich-
text format of all input/output files. They can now include any embedded or linked
objects, such as figures of the analyzed structure (in the input file) and figures of
deformations and stresses/strains in the output file. The resulting files are slightly
bigger but inclusion of graphic information makes the files’ content much more
descriptive. The files can be viewed and edited by editors supporting rich-text
format, (such as MS Word). Of course, AtenaWin can be used as well. Note that
any embedded or linked object in the ATENA input file does not affect in any way
the actual input data for the analysis, because they are automatically skipped during
the execution.
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[/inbuf size=i] [/outbuf size=j] = option that allows to specify size of file buffer for input and
output AtenaWin window. By default input windows and output window uses 2560
and 25600B long.

[/num_threads=n] = use n threads during the execution. By default all available processor's
cores are used.

[/num_unused threads=m]= same as the above but Atena will use number od processor's
available threads minus m. The parameter [/num_threads=n] has higher priority.

[/num_iters_per thread=m] = chunk size for dynamic schedule, =0 for static load distribution;
default=0
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3. ATENAWIN EXECUTION DESKTOP

When AtenaWin is executed, it loads a requested analysis module (such as CCStructure.dll),
displays the desktop (see Figure 2) and it opens a (rich edit) window for each of the main
ATENA streams. Which files are connected to these streams depend on the command line
parameters of the AtenaWin command described earlier.
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Figure 2: AtenaWin desktop

It is main AtenaWin frame, from which any type of AtenaWin window can be opened or
examined. All AtenaWin commands are available thru application menu and important
commands have also their icon on AtenaWin toolbar bar of controls. The status bar presents
actual information from AtenaWin, such as line and column number during file editing,
execution phase during analysis (in form of a progress bar) and so on.

3.1. Execution streams

As already mentioned, any ATENA analysis needs four streams. Each of such a stream can be
connected to one of the below:

1. File that is read/written directly from/to a disk,
2. File currently editable in AtenaWin window,

3. Standard system input/output stream.
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By default, the option add. 2 is used. The settings can be changed prior the analysis by
subcommands from Application menu. For example, to connect ATENA input stream to a
disk file use command Application->Input->Input File.

i
Use command Menu->Application->Current setting or click M icon from the tool bar to see
or modify current settings. It produces an information dialog:

Current setting [—Jﬁ
[mput ]
| S FC Statuz
Filer o\ Temphbrick_shell_30.inp Default ="5"
_ _ File ="F"
| Force zave new file upon catch i Catch ="C"

| Recommend save modifed file before execution

Stop after each command. Exec from break to cont,

Output
H 5 FC
File:
Meszzage
S FLC
File:
Errar
File: SFPC

Figure 3 Current ATENA file setting.

,»3“ means the file is connected to standards system file, ,,F* means a direct connection to a
disk file and ,,C* indicates connection to an AtenaWin window.

The far easiest way to connect a file to ATENA input stream is to a file explorer. Find the file
you want to connect to and drag its name onto AtenaWin desktop. The file gets opened and
shown. Then, click icon on the toolbar. Use exactly same steps to connect (i.e. catch) the
other analysis streams to appropriate disk files.

The checkbox "Force save new file upon catch in" is self-explanatory. If the checkbox
"Recommend save modified file before execution" is checked, then provided the input file has
been modified, prior a subsequent execution a dialog is presented, where the modified file can
be saved before the execution begins. Note however, that the save operation is not necessary
for the execution with the updated version of the file. It is recommended meerly for safety
reason to be sure to save the file for its future use. The checkbox "Stop after each
command..." is just GUI version of DEBUG ON|OFF commend. When checked, the
execution stops after processing each main command. It gives the user chance to conveniently
debug its input file during the execution. When the execution is stopped, you can issue any
Atena commands, e.g. a command to produce an alphanumeric output to the Atena *.out file,
set or just have a look at any 2D/3D output graphics etc. The execution can be resumed by
pressing the buttons "Execute form break" or "Execute from cursor". In the first case the
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execution continues at the next command, whilst in the latter case the execution point is
moved according to the cursor position within the pane with the caught-in input file.

Another useful dialog box is available via Menu->Application->Automatic save”. It allows
setting of a time period, after which AtenaWin automatically save all caught output data. It
preserves some results (from long executions) even in a case, when they were not properly
saved (e.g. due to an exception in the execution). When the “Save” button is depressed, all the
output data are saved immediately.

Automatic save

Save modified catch oubput

Automatic save after (secs) | 0

Manual save now! Save

Figure 4 Automatic save dialog box.

2 This feature is available in Atena Version 4.0 and newer.



14

3.2. Execution toolbar bar with controls

The bar with description of the controls is shown in the next picture:

/ New file/window

// Analvze from scratch | | Cont —after break | | Cont. the anal. from cursor
::r Restart the analysis
1 Suspend/ resume the execution

] 7 Stop the analysis after step

A Stop the analysis after iteration.

i} Stop the analysis ASAP
B Change/  show  current
Els Output data default directory

] Catch  the  active
= Catch the active window window as input stream
= as output stream

5
%\\ The same for message stream

The same for error stream.

Atena streams connection summary

Figure 5 Execution tool bar

Most of the above commands are self-explanatory. (When cursor is placed for a while atop
most icons or menu items, a short help string at the status bar is provided. If a command (or
an icon) is dimmed, the related function is not available for the currently active window. More
help is available in Help menu that opens files with ATENA documentation.

The Execute analysis command starts the analysis of ATENA kernel. Use the Stop ASAP (as
soon as possible) command to prematurely terminate the execution immediately. There are
more options to stop the execution in menu Application.

Restart analysis command destroys the current execution model incl. all its output data,
particularly those in postprocessor and 2D plot windows and re-executes the analysis from
scratch, i.e. it executes all commands in ATENA input stream.
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Continue analysis command is intended for continuing the current analysis. It executes all
commands from input stream starting from the current cursor position up to the end of the file
(or Terminate command).

Therefore, Restart analysis should be used after editing the analysis model to get updated
results, while Continue analysis is aimed to be used to output some more results form the
current analysis, execute the next time execution step(s) etc.
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4. POSTPROCESSING RESULTS

All results for material points, elements and/or global nodes can be postprocessed using one
or more AtenaWin postprocessing window. The kernel facilitates full 3D fast visualization
based on OpenGL library. A model being examined can be depicted in its undeformed and/or
deformed state using wire or rendered visualization of the structure. It is possible to control
direction of view, light, clipping planes and many more projection parameters to fully
customize all view characteristics as needed. The views can be exported as bitmaps to any
thirdly party graphical editor, where additional editing can be carried out. Bitmap size is also
customisable in AtenaWin.

A typical postprocessing window is depicted below.
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[l | [} |

Figure 6 Postprocessing window

A new postprocessing window is created by icon JE (or equivalent menu command
Application->Pre/Post-process of the window describes what data are visualized in the
window and the legend shows colour scale for the rendered results. (Note that colours are
affected by imposed light. If an exact colour matched contours are needed, switch the light

off).

The postprocessing window has its own menu commands and it also has a dedicated toolbar
with controls. The bar is depicted and described as follows:
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New pre/postprocessing window

=}

RisR Data for preprocessor model
B | Domain for preprocessor model

ﬂ\ Data for FEM model, (i.e. output)

Move, rotate and/or scale the
model projection

~~_| Domain for FEM model I

Specify global projection parameters

x Clipping planes specification

Zoom in frame/ zoom out

ERapro By g

Crack drawing options

o

Specify series for 2D plot MONITOR 2 or PLOT 2

Set several options for the picture

Create new window for 2D plots,
MONITOR 1 or PLOT 1
\ Create new window for 2D plots,

Redraw the window

Figure 7 Postprocessing toolbar

Note that disabled, (i.e. dimmed) icons used for specification of 2D plots.

4.1. Model projection

A way of how an actual model is projected into a 2D window depends on global projection
and model transformation parameters.

4.1.1. Global projection parameters

This set of parameters defines how to project 3D global coordinate system into a 2D system
of the viewing window. The parameters are set by a dialog invoked by a menu command

Properties->Global projection, (or the icon '}“). This command opens the following dialog
with the sheets:
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Predefined projection. This sheet is the most commonly used sheet for definition of
projection parameters. X/Y/Z means projection in direction of aforementioned axis; +/-
sign is used for positive/ negative direction of the axis. As an example, depress —X-Y-Z
button to watch the scene as shown in Figure 6, (the red/gree/blue line is X/Y/Z axis
respectively). The other buttons control lighting of the scene and option of immediate or
postponed reaction on changes of the projection setting buttons.

Global projection

Yertical direchion
Predefined projections

Yiew centre
Yiew direction

Light
v Adjust direction

v Switch ondoff

Chirnetry
+ | +7 | +Z |
® | _x |_Z |
Trirmetry
X | 0 | H1E | XL |
WL | L | T b

| et |

Cancel | Apply |

l
|

Figure 8 Predefined projection sheet.

View direction. Specifies a vector, in which direction the 3D FEM model is to be
observed. By default, the vector {-1,-1,-1} is used, i.e. isometric view from the first
quadrant of x,y,z space in the direction towards the origin. Meaning of the remaining

buttons is the same as above.

-~

Global projection

=,

WVertical direction
Fredefined projections

Wiew centre
Wi direction

Specifiy direction of your view
e.0. vector at which you want
to see the drawing centre

"
Y|.1—
z [

Light
[w Adjust direction

v Switch on/off

F'reviu:uus| I et | Cancel | Apply |

|

Figure 9 View direction sheet.
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Vertical direction. Set which direction from the 3D space should be transformed into
vertical direction in the 2D projection space. By default it is {0,0,1), i.e. the 3D z axis will
be plotted vertically. Meaning of the remaining buttons is the same as above.

Global projection
Predefined projections ] Yiew directian ]
Yertical direction l Yiew centre ]
by ||:| Specifip vectar [in =7 that
ghould be displayed| in vertical
direction
v |0 Light
[w Adjust direction
z | W Switch on/off
Previouz | M et | Cancel | Apply |

Figure 10 View direction sheet.

Centre point. Defines point where the 3D coordinate system should be placed, (or in other
words it sets a point that will be projected into centre of the window). The button Reset
resets the X,.Y,Z values, so that the 3D coordinate system will move into the centre of the
model. If X,Y,Z values are zero, the original XYZ coordinate system of the model will be
drawn (without any shift). Purpose of the remaining buttons is the same as above.

-

Global projection
Predefined projections ] Wigw direction ]
Wertical direction Wiew centre

v li Specify view centre in global #vE
cordinates and move there onigin

N aof the drawn awes

Z Light Fix coards.

Coordz via node id v Adjust direction
5 | |

Previous | | Cancel Apply

[w Switch ondoff

Figure 11 Centre point sheet.
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If ground plan of the model is to be produced, specify view direction {0,0,-1} and vertical
direction {0,1,0}, i.e. y axis vertical. Similarly, to see x-z plane side view of the model,
specify view direction {0,-1,0} and vertical direction {0,0,1}, i.e. z vertical.

Direction of light is set in the same manner, see command Properties->Light position.

4.1.2. Model transformation

This is the second set of parameters affecting the model’s projection into a viewing window.
It enables additional model translations, rotations and zooming within already projected
global coordinates of the model, see the Global projection parameters above. In words of
OpenGL graphics, whilst the first set of the projection parameters, i.e. Global projection
parameters specifies projection transformation of the scene, the second set, i.e. Model
transformation specifies model transformation. A dialog to input the model transformation

&y

parameters is invoked either by clicking the icon
transformation. The dialog is depicted in Figure 12.

or from menu Properties->Modal

The projection parameters can be set for each direction x,y,z separately (with the Gang button
unselected) or the same value for all the three direction is applied, (with the Gang button
selected). The dialog is used for zooming, rotating and/or panning the current view. The reset
buttons always reset the default conditions, i.e. the whole model is depicted in the middle of
the window.

- - .
Model transformation Model transformation Model transformation
Flotate Zoom Pan
= by z bt Y it = e d
-180 = - - 01 | = | = | = 10 - - -
0 S - S 5 0 —_ __/; L
180 - - - o - = = 10 = = -
|_Track |_Track |_Trac:k_
Eentrel Reset | Reset | Reset | Eentre| Reset | Reset | Reset | Eentre| Resat | Rasat | Resat |
Rotate Zcu:rn| Fan Gang| 0k | Fh:tate| Zoom  Pan | Gang | 0k I Fiotate Z.;..;ml Pan Gang | | oK. |

Figure 12 Isoparametric Projection dialog.

If the Track button is selected, any move of the sliders from is immediately reflected in the
view, i.e. it allows continuous zooming etc. In case of very large models graphics
performance of the computer may not be fast enough to respond immediately any slider’s
move and it is better to carry on the view redraw only at its final position. This is achieved by
deselecting the Track button. A final position is obtained, when handle of the moved slider is
not clicked anymore.

The Centre button invokes a dialog to set view centre of the scene, which is crucial for any
rotation operations.
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4.1.3. Panning picture by window sliders

The last possibility to affect the model projection is to drag handles of bottom and right hand
side scroll controls of the display window. It pans the picture in local ie. 2D view
coordinates. Note that selecting or deselecting of the above mentioned Track button has effect
also on this transformation.

— N— —

es Application  Help
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Figure 13 Panning sliders.

4.1.4. Isoparametric clipping

During projections from 3D model space to 2D projection space the model is scaled to fit into
a cube of size 1, i.e. local x,y,z coordinates in range 0-1. The 2D space is actually also 3D
space with its z axis pointing out-off the picture’s plane. Local x is horizontal, y is vertical
and z is out-off plane axis (or picture depth). By using command Properties->Clip planes you
can change dimension of the cube that will be drawn into 2D view picture, thereby it is
possible to clip the picture as needed.

OpenGL graphics offers a rich set of transformations to customize final view of a 3D object.
However, mastering of all visualization power and projection flexibility is difficult, unless
you perfectly understand, what is happening during any of the transformation used.
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The same applies also for AtenaWin. However, it is believed that rather than limiting
available projection parameters (and thereby simplifying the AtenaWin GUI), the better
solution is to offer all available projection controls with a chance that a user does not use all
of them right from his/her first execution of AtenaWin. When he/she get more familiar with
AtenaWin, the remaining controls can be quite useful.

The best way to get familiar with all the projection parameters is probably to play with it and
see, what effect they have. The command is invoked via menu command Properties->Clip
planes and it presents the following dialog:

Clipping Planes

Walues 0...7 faor the whole picture
Left: ||:|

Right: |1

E attarm: ||:|

Top: |1

Mear: |'1 0o

Far: |-I 0o

Cancel

Figure 14 Dialog for setting OpenGL isoparametric clipping planes

4.1.5. Additional clipping planes

OpenGL library offers specification of additional up to 6 clipping planes that can be used to
clip some parts the scene. They are most often used similate model ‘s cross sections. They are
also usefull assessing for model’s details during its modelling by T3D generator. The
OpenGL clipping planes and some AtenaWin native clipping options are available thru menu

command Properties->Additional clip planes, (or the icon =—). It presents the following
dialog:
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Planes Fetch coords

#, s Z Mode MMode

Node1 [0 0 0 Grab | Grab
Mode 2 ||:| |EI |EI Grab | Grab
Mode 3 |':| |U ||:| Grab | Grab

Sel Sel
Plane 1 Plane 2 Plane 3 Plane 4 Plane 5 Plane B ﬁ ﬁ

Show Shu:uw| Shu:uw| Shu:uwl 5hu:uw| Shnw| 3
Retain N2

Enable| Enal:ule| Enable| Enal:ulel Enal:ule| Enable| -
N1 mowe

FEM model element surfaces
Cancel
I Culing back faces [ Remave intemal faces
Apply

Figure 15 Extra clipping planes dialog.

Each of the 6 clipping planes, i.e. Plane 1 thru Plane 6 is defined via X,Y,Z model global
coordinates of three point, see the sketch in the above dialog. AtenaWin clips out halfspace in

front or in back of the plane defined by a three nodes. After depressing the button | Show
below a particular plane, (e.g. ‘Fa"& 1) current coordinates of the three definition points are
shown and can be edited. They can be directly input or they can be grabbed from the OpenGL
window by pointing a FE node, see buttons 5l |and _Brab

The button EnabE] pbelow e.g. Flanel enables or disables the clipping plane 1. The similar
applies to the remaining clipping planes.

The Model minimum and maximum model coordinates are available from the main OpenGL
window.

Use culling back faces flag to draw only front faces or to draw both front and back faces of
the elements. The Remove internal faces flag is used to draw only external surfaces of the
model or to draw all faces. By default, only front external faces are drawn. This is the best
selection for drawing the whole model, i.e. if no clipping plane is enabled. In case of an active
additional clipping plane it is usually better to switch both the flags on.
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4.2.

Show FEM output data

Menu Command Draw->FE Model, or icon IE can be used to specify, what output data
should be rendered in the postprocessing window. The command draws the following dialog:

-,

Post-processor data
Awailable data M_ Switch for
CURRENT NODAL COORDINATES ¢ Draw autput draw/  don’t
DISPLACEMENTS draw output
ELEM_TOTAL TEMPERATURE
EXTERNAL FORCES Las=far
INTERMAL FORCES = Gibd o
HSEE«L_DEEHEES_DF_FHEEDDM obal nodes Location
PARTIAL_EXTERMAL_FORCES *" Elepertnodes type
P4ATIAL INTERNAL FORCES ~
PARTIAL REACTIONS Elements
PARTIAL_RESIDUAL FORCES  Elements [P
PRINCIPAL_STRAIN
PRINCIPAL_STRESS
REACTIONS
REFEREMCE_NODAL COORDINATES Item
E‘%glﬁHﬁL—FDHEES (3] — - Select output
STRESS data item
TOTAL ELEM_BODY LOAD
TOTAL_ELEM_INIT_STRAIM Cancel
TOTAL ELEM INIT_STRESS
| Apply |
_ Fier—] Set filter for
available data

Filter string

Current string used For Filkering output data
| MOMITOR SET 1

Add predefined prefix
Manitor setis) 1 Stress fidd
Manitar setis) 2 Add Skrain Add
Selection(s)/List(s) Add Displacements  Add
Tokal element load Add Crack width Add

Ok | Cancel |

Figure 16 Output data dialog

The Available data rectangle present all output data currently available for specified location
type. This list changes based on selected location type. For example, one output data can be
available for structural global nodes, (e.g. displacements), while the other for elements only
(e.g. element incidences).
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If the “Available data” listbox displays too many data to find the data we want to display, use
the data filtering. After pressing the “Filter” button it is possible to define a substring and
afterwards only data containing that substring will be displayed. Several useful substrings are
predefined.

Note that output data for the Element IPs location is visible only at element IPs, which are
requested by the commands “Show->Element IPs loc.” or “Show->Element IPs Ids.”, see the
section “Selections and Show/Unshow specification” described later in this manual. The
dialog displays the same output data identification strings as those used in *.inp input stream.
For more information see ATENA Input file format documentation manual. As an example, if
you want to assess strain in x direction, choose data ENGINEERING STRAIN, location
Global nodes and item eps_xx.

4.3. Draw domains specification

AtenaWin can analyze very large models. In such cases, it is often needed to visualize only a
part of the model. One way to achieve this is to use window clipping as described in Section
4.1.3 Clipping. It works firmly well, however, it may be sometimes more convenient to
restrict part of the structure for drawing by specifying range of element groups and/or
elements, (or possibly element nodes) to be drawn directly. It is achieved by the following
dialogs.

Note that the colour scale in the window’s legend is always assembled only for the selected
part of the structure and thus (in the automatic regime) the scale presents maximum and
minimum values for the output data for the depicted part of the structure, (e.g. max. and min
stress in x direction).

Draw domain dialog pages are accessible thru menu command Draw->Domain or by clicking

"""" . First, it displays the dialog below, where it is possible to choose, what element groups
should be depicted. Each element group (defined in the model) appears as a line with the
following information:

e Check box indicating plot selection of the group,
e Shape of the elements of the group with element type within the brackets,

e Name of the group, typically a user description of the group either from the *.inp file,
or from a preprocessor that generated data for the element group.

Below the listbox in the dialog there are a few buttons that allow fast selection/deselection of
all/1D/2D and 3D elements. The specification in this dialog should be understood as
additional constraints to those given on the other pages of “Draw data for window” dialog
sheet.
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Draw data for window DISPLACEMENTS at location: NODES for item: X(3)

-

Draw nodes' domain
Groups' activity check list box

— Groups to be drawn. Farmat [ group's shape(element twpe): group's id - group's name
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Presiaus | Mext | Cancel | Apply
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The next dialog page for selecting elements to be visualized is as follows:

Draw data for window DISPLACEMENTS at location: MODES for item: X(3)

-

Ciraw niodes' domain
Groups' activity check list bow

Coordinates values limits
Draw elements’ domain

— Current output subdamain interval
Sel
Interal id: I 3‘ Selection: —

- —I Grab

MHew Int.

Lewvel From To By
Delall
- | e

—I I I I Dl Int.

Previous | Mewst | Cancel Apply

The dialog page for selecting element nodes to be visualized. There will be drawn all

elements, whose at least one node matches the specified criteria.
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Draw data for window DISPLACEMENTS at location: MODES for item: X({3) l

Groups' activity check lizt box ] Diraw elementz' domain ]
Draw nodes' domain l Coordinates values limits ] L

Current output subdomain interal
Sel

Interval id: El Selection; | J Grab
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Level Fram To By W
=
J | | | Drel Ik,
Previous | M et | Cancel | Apply |

The dialog page for setting a part of the structure to be drawn based on the coordinates and
displayed values limits:

Draw data for window DISPLACEMENTS at location: HODES for item: X{3)
Groups' activity check list box ] Drraw elements’ domain ]
Draw rodes' domain Coaordinates values limitz
Feference coordinates and output values limit specifications Lirnitz switches

Mir. M. Off  On *0n

Ref.)  |1e+020 [Te+020 N el e

Ref.  [1e+020 [Te+120 &

Ret.- 2 1020 [1e+020 &
YWl

TE ez 1 e+020 “

Presvious | | Cancel | Apply

Figure 17 Draw domain dialog

A part of the model to be drawn is specified by setting one of the following three options:

1. One or more intervals of element groups and elements of the model, see the dialog
page 1.

2. One or more intervals of element nodes of the model. Each element, whose at least
one node matches the interval, will be drawn. (The dialog page 2.)

3. Minimum and maximum limits for X,Y,Z coordinates and/or for depicted value in the
node. Similar to the node specification above, at least one node of an element must
match the criteria in order to draw the whole element. (The dialog page 3).

Number of interval specification is not limited. If only a range groups is input, all elements of
the specified groups are depicted. If no range for element groups is given, the whole structure
is. It is default option. The intervals can be added, edited or deleted, as requested. Current
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specification is displayed in the bottom list of domains. Maximum and minimum limits can be
enabled, disabled or use inverse condition. This criterion is very powerful, if for example plot
of elements exceeding a particular value is required, (typically to detect parts of the structure
that has already collapsed). It is possible to set the draw domain criteria using the any dialog
pages simultaneously. In this cases only elements satisfying all criteria, (i.e. criteria from all
dialog pages) will be displayed. It is also worth to mention the possibility to select parts to be
drawn graphically. It is done by the butons “Sel” and “Grab” in similar way as in other input
dialofa, e.g. the output data dialog.

4.4. Show geometric model data

AtenaWin can display results from FEM model and analysis, as well as geometric model that
was used to generate the FEM model. These are data used by the T3D generator and data for
ATENA genuine generators, such as data for generating discrete reinforcement bars etc. In

order to draw model, use menu command Draw->Geom. model or click icon @ AtenaWin
displays a dialog displayed in Figure 18. It gives you a chance to choose, what should be
drawn and annotated. For explanation of T3D’s entities, (i.e. vertices, curves etc.), please
refer to the T3D input file format manual. Clicked entities are drawn, un-clicked are skipped.

Note that a picture of FEM output data and T3D model can be combined in one window.
Result may resemble Figure 19.

-

Geometrical model data

T30 tModel data
[ “erlicez

[ Curves
[ Patches
[ Shells
[ Surfaces

[ Regions

tacro entities

Cancel
| Macro nodes
Apply
[ Macro elements

Figure 18 Dialog for draw of geometrical model.
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Figure 19: FEM output and T3D model drawn in one window.

4.5. Draw domain for geometric model data

Similarly to output data AtenaWin allows to specify drawing domain also for plotting the
geometric preprocessor. The domain is set in form of multiple intervals for each preprocessor

entity separately. The current selection is displayed (for the selected entity) in the “List of
nodal subdomains” window.
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Figure 20 Dialog for setting domain for preprocesor data

4.6. Draw properties specification
This section describes several options that can be specified for postprocessor drawings by

menu command Properties->Draw properties, or by clicking icon e . The command displays
dialog from Figure 21. Meaning of the available options is self-explanatory.

Rendering colour can be set for 5 values, typically in range from maximum and minimum
values. Min and Max values are limit values for drawing the colour scale in the legend. Note
that colours on rendered surfaces of the model are influenced by light conditions. Hence,
switch the light off, if you want get perfect match with colours from the scale in the legend.

The combo box “Data” makes possible to choose, what output data should be used for
drawing the “deformed” shape *. Of course, in most cases structural displacements are chosen
by default, but e.g. for dynamic analysis you can also use accelerations or velocities, as well
as eigenmodes, it they have been calculated.

Two types of scale specification are supported, namely absolute and relative. In the former
case, all structural deformations are before drawing enlarged by factor of scale value from the
dialog. In the latter case the deformations are enlarged by factor scale value times maximum
size of the structure divided by maximum displacement.

3 This feature is available in Atena Version 4.0 and newer.
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Figure 21 Draw properties dialog.

The check box Black on white colour model, so that black background gets white and white
foreground gets black. Set this option to “Yes” particularly for printing the drawing.

Another important control is Redraw after. It sets, when the drawing is updated during the
analysis. It can be requested after each iteration, after each step or only on manual request, i.e.
clicking icon. The control below, i.e. Draw mode, specifies how the graphics window is to be
redrawn. The default mode, i.e. Draw mode=Automatic, means that at the request the window
is recalculated and redrawn directly from the model database. At the same time, the picture is
cached. If the window cannot be redrawn, (e.g. due to the analysis is currently in progress),
the window is redrawn only from the cache. The other two options restrict redraw mode to
always redraw from cache or from the model data. Note that unlike the other options within
the Draw properties dialog the options Draw mode and Redraw after apply for all windows
within AtenaWin.

4,7. Exporting postprocessor window

Any AtenaWin postprocessor window can be copied to the clipboard and pasted in a thirdly
party application for some additional processing. The application must by able to paste device
independent bitmaps. Use menu command Edit->Copy All to copy the whole picture.

The bitmap‘s resolution is important factor for quality of a final picture. CRT monitors
typically work with resolution at about 60 dots per inch (DPI), whilst laser and inkjet printers
are capable for printing at 1200DPI and higher. The higher the bitmap’s resolution, the higher
memory and CPU requirements to work with it. A selected optimal size of the bitmap is
therefore always a trade-off between picture quality and requested resources. Use command
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Edit->Clipboard resolution to specify values that best suit your needs. Also, when the map is
not needed anymore, use command Edit->Clear clipboard to release memory occupied by the
bitmap.

4.8. Selections and Show/Unshow specification

The 3D OpenGL graphics windows allows to select a FEM or preprocessor’s entities that are
subsequently somehow used. For example, it is possible to select finite model nodes, for
which displacement output is requested, (see the Grab sel(ection) of the Output data dialog.
The selection mode is invoked either via pressing the right mouse button atop the graphics
window or by Menu->Edit->Select. It follows to choose what should be selected. Then, left
click on an entity, you want to select. It is possible to select more entities by pressing Shift or
Control key while clicking on the entity or by pressing and holding left mouse button at one
location and moving and releasing at another location. In this case, all entities within the
drawn frame will be selected. The same operation is used to unselect entities, show entities’
ids and locations. Note that the cursor shape reflects a selection or show operation mode.

4,9. Zoominframe, Zoom out facilities

The previously discussed Model and Projection transformations define the way the FE model
and/or geometrical preprocessor’s model is depicted. However, AtenaWin offers additional
mechanism for setting the current projection parameters that is particularly useful for quick
zoom in frame/ zoot operation. It is invoked either via pressing the right mouse button atop of
a graphics window or by menu View->Zoom. A frame, into which it should be zoomed, is
drawn in the same way as the selection frame described in the above paragraph. It is possible
to concatenate “zoom in frame” operations, however, the zoom out removes always any zoom
specifications and return to the original Model and Projection transformation.

4.10. Inputting a new command and input/assess dialogs

At any idle time of AtenaWin it is possible to issue a new input command. Such a command
can e.g. edit/add the existing data, it can output some results etc. The command may be typed
into the AtenaWin input file and executed thru menu commands Application->Continue
Execution or Application->Continue from Cursor.

Another option to specify and execute a new command is to employ the “Input” menu
commands, see the figure below. (Note that this menu is only displayed, if we select an
AtenaWin window with graphics to be active, i.e. not a file editing window!).

PLACEMENTS at location: MODES for item: X{3)
adowfs)  Inpuk  Cubput  Draw  Properties  Application  Help

FEM Generator  *»  Macro Node s | e
e— FEM Cammands  * T3D Entities :
Command Line ” ! DISPLACI

rgence criteria 1-4

Figure 22 Input menu
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The input functionality of AtenaWin is still in development. Currently only the most frequent
commands have their input dialog. The remaining commands must be input via Input->Input
Command menu.

4.10.1. FEM Input->Input command

It opens an editable line, where any command can be typed. The command is input in the
same form/syntax, as it would be typed into the ATENA input file. Upon pressing the Execute
button, the command is immediately executed.

4.10.2. FEM Generator subcommands

This submenu calls dialogs for inputing data processed by native ATENA pre/post-processor.
Currently, only macro nodes can be input, see below

-

Hode
MHode 1d.
1 j Sel | Grab
# |-4.1 141939798597 35e-006
b ||:|
z ||:|
Drraw | Select |Hemu:we| Cancel .-’-'-.ppl_l,ll l

Figure 23 Macro node input dialog

Functionality of the controls of the above dialogs are:

Node Id. edit line — direct input of input/assessed/edited macro node. Alternatively, an
existing macro node can be selected by the spin control, (i.e. arrows up and down). A
macro node can be also selected graphically. To do that depress the “Sel” button,
move the cursor atop the requested macro node and click the left button of the mouse.
The macro node gets selected. Thereafter, depress the “Grab” button and the nodal ids
is copied into the edit line and all remaining controls of the dialog are updated
accordingly. Note that “Sel”/”Grab” buttons can be also used in more advance way:
select any number of macro nodes (e.g. by selecting macro nodes by a selection frame,
by repeated selections (e.g. Ctrl-clicking the left button of the mouse) etc. Then click
repeatedly the “Grab” button. After each click, one of the selected macro nodes gets
deselected and it is “copied” into the dialog box. Checking the nodal coordinates one
can verify that the dialog works with the requested macro node.

X,Y,Z edit lines — input/assess X,Y and Z coordinates of the selected node.

Draw button — depress this button to modify X,Y,Z coordinates of the node
graphically. Moving the cursor atop of a graphics window causes the current model’s
coordinates are copied into the dialog. See View->draw Plane/Grid input sheet to
specify the input working plane and/or grid/snap support.
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e Select — the button gets depressed, if an edited macro node (within this dialog) has
been selected. This control can also be used to change the selection status for the
edited macro node.

¢ Remove —remove the macro node node id from the FEM model.
e Cancel — close the macro node dialog.

e Apply- generate and execute appropriate input command to carry on data changes
corresponding to values in this dialog.

4.10.3. T3D generator subcommands

Use this submenu to input/assess or modify T3D vertices, curves, surfaces, patches, shells
and/or regions, see e.g. Figure 24. The provided dialogs are similar to that for macro nodes
and also use of their controls is self-explaining. The dialogs slightly differ depending on the
entity, which is to be input. Some of the dialogs are more complicated then the others,
because e.g. in some cases sign of the parent entity has to be regarded, (+/- are used to specify
orientation of the entity), the input entity can be specified using several types of parent entites
etc. For example, (referring to the Region input dialog in Figure 24, a region can be specified
using parent surfaces and patches and a patch can have its normal pointing outside or inside
the region. More explanation on how to input a T3D entity is available in the ATENA T3D
input file manual.

T3DEntities

Wertex l Curve ] Surface] Patch ] Hegiun]

Wertex |1d
Id i j
# 0
| Ciram
z ||:|
Nodal prop. |suppart_right -] B
Remove Eancel R

Figure 24 The Region dialog

4.10.4. FEM commands

Use these subcommands to specify native FEM data. Currently only dialogs for FEM node,
FEM element and Atena lists are provided. Use of the dialog is similar to the above dialogs.
Note that pressing the “Select” button of the List dialog causes selecting/deselection all finite
nodes/ finite elements specified in the list. This can be used to verify content of automatically
generated selection lists in ATENA. Just choose a proper selection list name and depress the
“Select” button. All the nodes/elements within the list will get selected in the AtenaWin
graphics window. Remind that ATENA supports selection lists of several types. The most
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common are the already mentioned finite nodes/elements lists. However, they are also multi-
selection lists etc. and therefore, the dialog also support input of so called “general” type
selection list. In this case, selection, grabbing and any other graphics functionality is disabled.

4.11. Displaying cracks with the structure

When calculating a R/C or concrete structure, it is possible to display cracks within the

concrete. Pressing the icon 4 will invoke the following dialog:

= =]
Diraw Crack Options
Where cracks should be drawn
Mowhere (v ‘Yes
Averaged at element [ Yes
Ak element's IPs (" Yes

Filker Faor cracks ko be drawn

Max, crack level |3
0

fin. crack width

Shyle
Widtb mulkiplier | 1

Shift outwards |0
Cancel | Apply |

Figure 25 Draw crack options dialog

where draw crack options can be specified. Cracks can be draw at element center or they can
be drawn at each material point. The remaining parameters set crack line width, filter, (i.e.
minimum width for a crack to be drawn) etc.
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5. DISPLAYING 2D GRAPHS

AtenaWin (in additional to the above 3D OpenGL plots) provides support for simple 2D
drawings. One of such a plot is depicted in Figure 26.
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Figure 26 AtenaWin 2D plot

2D plots are particularly useful for tracking changes of execution parameters and data within
time (or load) span, i.e. for displaying of history of one or more development in the structure.
It makes possible to plot dependencies sort of structure load versus structure deformation,
history of crack developments etc. The plots are updated in run-time manner, so that they can
display structural conditions during the analysis.

The second way to use the 2D plots it to plot a set of output data over a particular domain at a
particular time. Virtually any ATENA output data can be plotted, see OUTPUT command
parameters MONITOR 1/2 and PLOT 1/2. As an example, one can plot structural
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displacements along a boundary of cross section, or to plot compliance function and shrinkage
of a creep material etc.

Two sets of output data are available. They are invoked via the icon [ and L# or
respective menu commands.

Note that AtenaWin (by default) defines a convergence monitor within the MONITOR 1
window. It allows the user to monitor ATENA convergence performance within all loading
steps and iterations.

5.1. Definition of graph series for the 2D graphs
The following two steps are needed in order to obtain a 2D graph in AtenaWin :

1. Definition of data that should be monitored during the ATENA execution and stored
in system monitor 1 or 2.

2. Definition of the 2D graph itself, i.e. setting which of the monitored data should be
used for graph series plotted in the graph

The first step is achieved by writing appropriate ATENA OUTPUT command in the ATENA
input stream. It is briefly described in this section. For more details refer to the ATENA input
file manual. Alternatively, use the Output data dialog of AtenaWin that makes compilation of
any OUTPUT command much simpler.

The second step specifies the plot itself. It is done by the AtenaWin Graph series dialog
described later in this document.

As an example, suppose you want to monitor maximum stress — maximum strain relationship
per analysis steps. You would issue, (i.e. put into ATENA input stream) the following input
command. It defines a monitor set called “stress_yy and strain_yy at right edge”. It contains
maximum values from integration points 1 and 2 from elements 1 and 2 of element group 2.
The first item (i.e. value) of the set (for each step) includes stress yy and the second is
engineering strain_yy. The values are tracked at each step (this is default) and is sent to the
AtenaWin monitor 2.

OUTPUT MONITOR_2 NAME "stress_yy at right edge"

LOCATION ELEMENT _IPS GROUP AT 2 ELEMENTS FROM 1 TO 2 IPS FROM 1 TO 2 DATA LIST
"STRESS" ITEM AT 2 "ENGINEERING_STRAIN" ITEM AT 2 END MAXIMUM

In a similar way, the next command defines a set the similar to the above, but values are
tracked at the end of each iteration and the maxima are calculated from all stresses
components. In this case the output is sent to the monitor 1, because it is more suitable for
“per iteration” based data.

OUTPUT MONITOR_1 NAME "all stresses” EACH ITERATION

LOCATION ELEMENT_NODES GROUP AT 2 ELEMENTS FROM 1 TO 2 DATA LIST "STRESS"
END MAXIMUM

The same effect is achieved as follows: In the AtenaWin graphics window select the elements
1 and 2 from the group 2. Invoke the AtenaWin output data dialog. In the “Location” combo
box, select “ELEMENT NODES”. In the “Requested/ available data” list select STRESS. If
this output option is not yet available, (because no step has been yet executed), type in the
output request ,,STRESS* to the list box directly (without the quotes). Select “Monitor 1 —
per iteration” option in the “Output type and monitor name” combo box and type "all
stresses” (without quotes). Depress “Grab sel.” button. Check the “Monitor iters’ check box
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and the “Find max” check box. Press the “Apply” button to issue the output command.
Alternatively, select the content of the “Output command” edit box, copy it into the clipboard
(By pressing Ctrl-C) and paste it somewhere to the beginning of the ATENA input stream.
This way the command will be carried out during the execution.

Full list of option available for OUTPUT command is beyond scope of this document. The
important point is that OUTPUT command is used to define data sets and these can then be
visualized using ATENA 2D plots.

Of course, any number of sets can be created as well as any number of plots can be drawn into
one 2D plot window (and any number of 2D window themselves can be used). This makes
AtenaWin plotting facilities a very powerful and versatile tool for examining structural
behaviour.

5.2. Graph series specification

New 2D plot window is created by menu command Application->Monitor or by clicking icon
l’;e. The next step is to define a plot. To do it, use menu command Graph->Series or click

icon b . The following dialog is presented:

Graph series

Select zere Fixed time
ie i - MHew Sene | Del Sern .
Seneid |q B SETIE el Serne M | J
Narne |-I Wertical | J

Horizontal walue [ Walues' profile for fixed time
M ame |Time j

W alue 1 = Factar |-|

Yertical value

Name |Eunvergenceh-1 orikor ﬂ

Apply
Walue 1 - Factar |1
SR coel_|

Figure 27 Graph series dialog

[rata zorting

¢ Mone © Honzizontal © Yertical

Typically, the first step is to click New button to create a new series specification.
Alternatively, specify an id of series that is about to be edited.

The next step is to specify output data to be drawn at horizontal and vertical axes. Click Name
combo box control and choose desired set name, (e.g. stress_yy at right edge in case of
the above Output monitor command). Click Value combo box and specify item number. Item
1 from the above Output monitor command corresponds to stress yy, item 2 to strain 2. The
edit box Factor allows you to set multiplying factor for the depicted value. For example, set
factor —1 for reversing axis direction.

The last edit box called Name (in Select Series group of controls) defines string that is used to
describe the series in the graph legend.
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The fixed timeframe is used, if (instead of plot history) it is required to plot results for a
particular time. In this case, one has to set fixed time for data for vertical and horizontal axis.
An example of such an output can be stress distribution along a particular line.

The last dialog frame is used, if a data sorting is needed. By default, it is switched off.

Selection of set name and item number the way it is described above is possible only, if the
output data are already stored in ATENA monitor (i.e. during and after the analysis). If you
want to specify the series’ specification before hand, (e.g. before any analysis), you have to
type the values directly into the combo box controls. They are both combo and edit controls.

5.3. Setgraph properties
Similar to 3D pictures the 2D plots have several options to customize the plots. Use menu

command Graph->Draw Properties or click icon ’#Q. It will produce dialog depicted in the
following figure

=

Graph properties
Graph Horizontal axiz Wertical axiz
Title |Eonvergence criteria 14 Manual [~ ‘es Floating [ ‘es Manual [~ Yes Floating [~ Yes
# lahels vertically v res Min. value Min. walue
Fedraw after

Iteratian - e sosthie l— Max value l—
Drawing made Automatic = Increment Increment

Line width 1 Mumber of ticks |4 Mumber of ticks |4
Fort factor 1 Label Time Label Relative emor

Cancel | Apply |

Figure 28 Graph properties dialog.

The dialog allows customizing horizontal and vertical axes, plotting title etc. If the plot is
about to be printed, usually higher line thickness must be used. The remaining controls are
similar to those for 3D graphics.

Note the option “Manual” and “Floating”. If none of these checkboxes are selected, scale of
the graph and an appropriate axis ticks are calculated automatically to display the whole graph
and to observe the “Number of ticks” value. If only the “Manual” checkbox is checked, the
graph is displayed and scaled according to the given axis range. The last option, i.e. only the
“Floating” is checked, causes that the only the last <“Max. value”— “Min. value” ...“Max.
value> range of the plot is drawn and it is labeled in “Number of ticks” point. It creates sort
of floating range, having length (“Max. value”— “Min. value”) and drawing only the very
recent values. Use this option to display a current and not very recent development of an
entity.

For explanation of the Drawing mode control, please refer to Draw properties specification.

5.4. Exporting 2D graph window

All 2D graphs can be exported in a thirdly graphical editor for additional processing. Use
menu command Edit->Copy All to copy the entire graph window to the clipboard and paste it
elsewhere.
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The window is transferred in metafile form, so that vector rather than raster graphics is used.
It has several implications: the transmitted picture data are small and are output at best
available quality. The picture is simply editable, whereby you are editing the whole entities
like text, line etc. Note that some graphics editors needs ,,ungroup* all entities (i.e. graphical
objects) prior the editing itself. For example, this is the case of Corel Draw editor.
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6. OUTPUT DATA

Alphanumerical, i.e. character-based output of any ATENA analysis data including its results
can be obtained by issuing the OUTPUT commands, see Menu->Output. The commands
forces ATENA to output the requested output data into ATENA output stream. The command
Output request allows printing of any currently available data at any number of analysis
domains, (i.e. parts of the analyzed structure). The command Monitor request is used to define
monitors of the analysis as well as 2D graphical representation of any printed data, (i.e.
PLOT _1/PLOT 2 options). The command Export/Import are used to export and/or import
monitors from previously saved binary archive files and the command General Option s make
possible to change some parameters controlling the way the data are outputted.

The input command OUTPUT wraps any request for alphanumerical output and as ATENA
output facilities are rich, use of this command may be a bit complicated. That is the reason
why AtenaWin offers a special dialog to assist the user. The output dialog is available from
both alphanumerical and/or graphical AtenaWin windows. It is invoked either form menu,

(item ,,Output®), or simply by clicking the icon from the AtenaWin toolbar. It is depicted
in the figures below:

The dialog page for specifying which output data are requested:

-

Cutput data for window DISPLACEMENTS at location: NODES for item: X(3)

Requested output data l Dutput subdomain intewal] Olutput u:-:ummand]

Requested £ available data Items [fram-»ta]

at lazation: | KWODES j Filer | |,£'-.II ﬂ
AL | =l

AL ~
CURRENT_NODAL_COORDINATES e
DISPLACEMENTS :
ELEM_TOTAL_TEMPERATURE Find min. [ max I
EXTERMAL_FORCES

INTERMAL_FORCES >

Proceszsing flags

Fecalculate output [

Mext Cancel Apply
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The dialog page to specify where the output is requested:

COutput data for window Set 1: ConvergenceMonitor ﬁ
Fiequested output data  Output subdarnain interyal | Output n:u:ummandl
— Current output subdornain interval
Sel
Interval id: |.1 3: Selection: INDnE ;I Grah
Mew It
Lewvel From To By
Drel &l
=P Jo I s
Del Int.
Previous I I et | Cancel Apply
The dialog page for definition of 2D monitors:
Cutput monitor data for window Set 1: ConvergenceMonitor ﬁ

Manitar definition | Requested output data I COutput subdomair inkerval I Cutput cormmand I

— Output type — Specific optionz
[7 Create window
tanitar 1 - time dependent ;I
[ tonitor each iter,
— Output name v tonitor racking
;I Rerave manitar |

Fresious Mext | Cancel Apply I




The dialog for setting output options:

.

General output data options

28 lniny y ==

General output otions | Output command |

Trace output in MPs
@ Keep cument settings

i@ Keep cument settings

Femaining options
Cutput ma. line length 200

Previous

Recovery strategy for MPs output -> element nodes output

(71 Vanational

[

(71 Each iteration (71 Each step

7 Lumped

(7 Mearest MP

Exdemal identfiers [ | Cache data

Cancel ||  Apply |

Export/Import definition of monitor data from previously stored binary archive files:

Export/ import monitor defintion ﬁ

Expart/impart manitars | 0utput command |

— Export/lmport monitors

v Automatically suplement manitars

dd file ¥ Erport ¥ Import
Removefile | [ Data [ Cods
F;
Fresiaus Hext I Cancel | Apply |
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The information dialog page that presents an equivalent output command that has the same
effect as the data from the current output dialog pages.

= T

General output data options

General output otions Output command l

Cutput cormmand
OUTPUT RECORD LEMGTH 200 |

Previous Cancel Apply

Figure 29 Dialog to obtain an ATENA output data

Typical use of the dialog is as follows: In the ,,Location* sub-window choose at what type of
location the requested output data are located and in the ,,Requested / available data* sub-
window select the output data itself. Depress the “Apply” button and the required output data
are printed into ATENA output stream. If more data are needed, repeat the previous steps.
The dialog is closed by depressing the “Cancel” button.

The above use of the output dialog will print the requested data from the whole model. This is
often not needed and you may prefer to obtain results only for some parts of the model. To do
that use “Current nodal subdomain interval” and “Items” sub-windows. For example, suppose
that we need only vertical (i.e. in Z-dir) displacement at nodes 1,2,3,4, 100,110,120,140 1000
and 1500. It is specified as follows: click the button “New”. Type 1 in the “From” sub-
window. Type 4 in the “To” sub-window. Type 1 in the “By” sub-window. Press again the
“New” button and in type in 100, 140 and 20. In the similar way enter the 3" output interval,
i.e. depress “new” and type 1000, 1500, 500. Click “Items (from, to)” sub-window and in
both sub_windows and select “X(3)”. That’s it.

Alternatively, in AteanWin Graphics window, select all nodes, where the output is requested.
It can be done e.g. by pressing the “Sel” button followed the actual selection. Then, return to
the Output data dialog and depress “Grab” button. The effect will be exactly the same as
setting output subdomains intervals manually as described in the previous paragraph. Be
careful that the selected output location type, i.e. the selection in “Location” combo box,
agrees with entity type, which has been selected. If e.g. some finite nodes are selected and in
the output data dialog “Location” box is Elements, than the selection is ignored and the output
data will be printed for the whole structure.

The “Interval id” subwindow allows you to check or edit any previously defined output
interval and the “Level” sub-window is used for multidimensional types of domains. This is
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for example location “ELEMEMT IPS”, i.e. data at element integration points. Its levels are
element group id, element id and integration point id. Input the interval specification from the
“lower” levels to the “higher”, e.g. groups first, followed by element ids and IPs.

The “Output type and monitor name” sub-windows are used to specify what type of output is
requested. The “STANDARD?” output prints data to ATENA output stream at the moment the
command is issued. The other possibilities are output to monitor, (type 1, 2) and output to
plot, (type 1,2). All the last four options are used in connection with the AtenaWin 2D plot
facilities. Hence what you type in “Monitor name” of the output dialog is what you would
look for at the “Name” sub-window of the “Graph serie” dialog of the AtenaWin 2D plot
window. The Monitor 1 — Time dependent option, i.e. MONITOR 1 window, is suitable for
monitoring data per iteration, the Monitor 2 — Time dependent option, i.e. MONITOR 2
should be used for monitoring data per loading steps. The Monitor 1 — Time independent
option and Monitor 2 — Time independent option, i.e. PLOT 1 and PLOT 2, should be used
for any plot that is drawn for one distinct time. (Typically it is the current time) and it’s up to
the user to choose, which one to use. Their behaviour is the same.

The Export/Import monitors controls can be used to export/import output data at current time
from/to the two system monitors. If the “Export” control is checked, the current output data
from the both monitors, i.e. from the Monitor 1 and Monitor 2 are exported to a user defined
external file. That file can be later used for importing the data. To do so, check on the
“Import” control, specify import file(s) and click “Apply”. The “Data”/“Cmds” set that output
data/monitor output requests are processed. If both “Export” and “Import” controls are
checked, AtenaWin automatically add the output data history into the monitors. For each of
the specified archive files it restores that file, (i.e. state), executes current output monitor
requests and exports all results. After that, it restores back the current state and imports all the
exported data, thereby adding output data history, (i.e. monitors) from the specified archives.

The “Other option” sub-window is used to select options for a special output processing. This
may by for example to print only maximum or minimum value of the output data (over a
specified domains) etc. All the options have an equivalent in the OUTPUT command and they
are described in ATENA Input file manual.

The last sub-window worth of mentioning is the “Output command”. It continuously shows
an OUTPUT command that is equivalent to the current selections within the output dialog. At
some situation it may not reflect the most recent selections. To be sure that content of this
window is updated, simply click on it. This window is mainly aimed to copy-paste ATENA
output data commands from the output dialog into the ATENA input stream.

There are several other sub-windows and options in the output dialog. However, its use is
self-explanatory and, (as already mentioned), in case of any hesitation please refer to ATENA
Input file manual, the section OUPUT command.
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7. ONLINE HELP

AtenaWin features several online help files. These include this manual, theoretical manual,
input file command manual etc. All of them are presented in *.pdf file format. Hence, Adobe
Acrobat Reader is needed to display (or print) them.

The help files can also be displayed within AtenaWin in an html based window. Use menu
command Application->Html viewer to open a new html-type window and open any
AtenaWin documentation file in it. Alternatively, it is possible to display any remote html file
by specifying the appropriate URL address.

Some help files can be also accessed directly by menu commands Help->Input commands,
Help->T3D generator etc. The command Help->Examples present a directory listing with
severe AtenaWin (and AtenaConsole) sample *.inp files. Each of such a file demonstrates a
typical set of commands for a selected analysis.

As already mentioned, AtenaWin’s html viewer can display any file created by an application
that supports Active Document server protocol. These are for example MSWord, Corel etc.
Of course, AtenaWin is merely client application that can work only, it the document’s Active
Document server is also available in the system.
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8. HowToDo....

The following Section describes procedures for carrying out the most common AtenaWin
tasks. Of course, the present procedures are not the only way, how to achieve requested goals.
Nevertheless, they should be simple and effective for use, (at least to the best of our
knowledge). The Section is expected to gradually grow up, partly as a feed-back to our
support help-line and the most common FAQs of AtenaWin users.

8.1. Supplementing output monitor data after execution of
the analysis

Output data monitors are typically specified via input file commands prior execution of the
analysis. In this case the output data are already collected into the output monitor container
during the problem execution.

However, if we need some more monitor output data even after the analysis execution, there
is still a way to retrieve the missing data from the execution’s archives and supplement them
into the monitor data. Of course, if no archives are available, the following procedure will fail.

The following lines describe how such a job can be done. The whole procedure is
demonstrated for the case of a 3D sample analysis from the file

“...\Atena\Projects\DLLs\Examples\AtenaWin\test_ex_import.inp”
where we want to get monitor of vertical displacement at the node 161.
These are the steps to do:

1/ Run AtenaWin.

2/ Open the file “AtenaWin\test ex import.inp”, execute the analysis and exit. The execution
will create archive files Consl.001, Consl.010, Consl.015 and Consl.020 with results from the
steps 1, 10, 15 and 20, see your working directory. The AtenaWin desktop should look
something like this:
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Close the current AtenaWin session.

3/ Run AtenaWin again. Restore the previous analysis: Click menu command ‘“Analysis-
>Restore from” and from the present dialog open the file Consl.020, thereby restoring the
state at the end of the analysis. The dialog should look like

-

Restore From -\
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ty Documents
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by Computer
’ -
Mp Metwork  File name: |I:|:unsI.D2EI ﬂ Open |
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4/ Specify a new monitor output data, for which you want the 2D plots. To do it, go to the
AtenaWin menu and press Menu->Output->Monitor request. It will display the Output
monitor data dialog.

5/ If not selected, choose Monitor definition dialog page and specify the monitor type, i.e. in
the “Output type” combo box select “Monitor 1 — per iteration”.

6/ Specify the monitor name. For example, type “monitor test” to the Output name control
(without quotes).

7/ Check or uncheck the Specific options, as required. Typically, you will want to check the
Create window check box, which take care about actual creation of the window with the 2D
plot. The modified dialog page should look like

Cutput monitor data for window Demo_L_RC_inp L ﬁ
Manitor definition | Requested output data | Output subdomain interval I Output command |
Cutput type Specific options
Create window
Manitar_1 - per teration - ]
[] Monitor each iter.
Cutput name Manitor tracking
- [ Remove monitor ]
Previous [ Mexd ] [ Cancel ][ Apply ]

8/ Select the Request output data dialog page. In the control “Requested/available data” select,
what you want to output, i.e. “DISPLACEMENTS”. In the control “Items (from->to)” select
“X(3)” in the both combo boxes. Thereby only vertical displacement will be output. The
result is:

Cutput monitor data for window atena.msg

bonitor definiion  Requested output data | Qutput subdomain intewal] Dutput cammand]

Requested / availlable data Items [from->ta)

at location: |MODES j |><[3] ﬂ
DISPLACEMEMTS |><[3] j
DISPLACEMEMTS [A] Frocessing flags
ELEM_TOTAL_TEMPERATURE

EXTERMAL_FORCES Find min. [ max [
INTERMAL_FORCES

NODAL_DEGREES_OF_FREEDOM v

Recalculate output |

Previouzs M ext | Cancel Apply
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9/ Press Next to display the Output subdomain dialog page to set location of the output. Press
“New Int” button to create a new interval. Default entry “Node” in the control “Level” need
not any change, so that we have to modify only “From” and “To” controls. Type in both of
them a node_in , where the output is needed, e.g. 161. At this moment, the output dialog page

should look like

10/ Press “Next” button to see an input command that is equivalent to the data in the Output

-

Chutput monitor data for window atena.msg

X

-

M anitor definitinn] Fequested output data  Output subdomain interval lEIutput u:u:ummanu:l]

Current output zubdomain intersal
Sel

Interval id: 1 E| Selechion: |Naone j Grab

Few Int.
Level From To By —D al
&
Mod - 161 161 1
= = | | | Del Irt.
Previous | Mext | Cancel | Apply

monitor dialog:

P

Cutput monitor data for window atena.msg

-,

11/ At this moment the new monitor is fully specified. Hence press “Apply” button to

b amitar definitiu:un] Requested output data] Output subdomain intersal  Oubput command l

Qutput command

OUTPUT MONITOR_T NAME "maritor_test” EACH STEP
LOCATION NODES

Node FROM 161 TO 161 BY 1

DATA LIST "DISPLACEMENTS" END ITEM FROM 3 70 3
TRALCK, §

Presvious | | Cancel | Apply

complete and execute the output monitor request.

12/ If you previously checked the “Create window” check box, you are now presented with
the Graph series dialog that allows setting of some additional parameters of the created plots.
Modify what ever you wants and press “OK” to close the dialog. A new window for 2D plots

will be created.
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The new window should look something like this. It has already axis, legend etc., however,
the actual data are still missing. They will be retrieved from the previous stored steps as
described in the following.

13/ Close the Output monitor dialog.

14/ The next step is to retrieve the new output monitor data from the analysis’s archives. Go
to the menu and press Menu->Output->Monitors Export/Import data dialog.

-,

Export! import monitor defintion

Expaort/impart manitars | Output command ]

Export/lmport monitors

[w Automatically suplement monitors

[ Preserve cument output options

Add file [ [+
Femove file | [ [+

I

Mext | Cancel | Apply

15/ If not seleceted, choose the Export/Import dialog page. Open the archives, from where to
import. Click “Add file” button and multiple select the archive files Consl.001, Consl.010,
Consl.015. The last one need not be selected, (i.e. Consl.020), as it was already used during
the restore of the analysis, see the item 3. If it is selected as well, it doesn’t matter. It will be
ignored anyway. The open dialog should be as follows:
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The dialog page should look something like

Export! import monitor defintion E
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and the equivalent input command from the Output command page should read:



Export! import monitor defintion

Exportlmpart monitors Dutput command

Dutput command
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12/ Press the “Apply” button to retrieve and display the requested “Displacement” output
data. Close the Export/ Import monitor definition dialog.

At this moment vertical displacement at the node 161 (from the steps 1,10,15 and 20) are
imported into the output monitor and can be output or visualized in exactly the same way as
any other output data, which were monitored already during the analysis. The output window

will display something like:

Jokb: ATENA, Log start: 27.7.2005 14:58% 03

ATEMNL Version 3.2.3 ic) Cervenka Consulting 1999-2005

monitor test Step: 15 TIteration: 2
monitor test Step: 1l Iteration: 3
monitor test Step: 10 TIteration: 2
monitor test  Step: 20 Iteration: 2

Job: ATEMA, Log end: 27.7.2005 14:55:12

The resulting 2D plot looks like:

Time:
Time:
Time:
Time:

15 -0

1 -0
10 -0
20 -0

.0109617
. 0007340
0073185
0146011
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Alternatively, the output location, (e.g. the node 161) could be selected graphically. Simply
press the “Sel” button and select, where the data are to be output and then press the “Grab”
button to copy the selection into the Output subdomain interval dialog page. The rest is the

same.

Note the checkbox “Preserve current output monitors”. If it is unchecked, then the
supplemented values (to be monitored) will be calculated based on the settings (see Output-
>General Options->General Output Options) that was in use during the execution of the
structure. Otherwise the current options settings will be used.

8.2. Saving and restoring an AtenaWin session (to continue a
previous analysis or post-processing)

There are three options to store/restore data from the current analysis that are to be used in the

future:

1. Store FEModel to/Restore FEModel from,

2. Save AtenaWinSession/ Open AtenaWinSession,

3. Save Figure Settings, Open Figure Settings
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The first option causes to store/restore data about a current FE model, i.e. a store/restore
current state of ATENA execution kernel. It includes description of a shape, dimensions,
loading, boundary conditions etc. of the currently analysed structure. It does not contain any
information on current windows and their layout and properties used for postprocessing. The
Store/Restore is available thru Menu->Application->Restore/Store FEModel... If you restart
AtenaWin and want to continue the analysis, i.e. to execute an additional loading step, this is
the way to restore the model analysis data from the previous analysis. After inputting
additional data describing the new load step, press the execute icon = to carry on the next
analysis.

The second option, i.e. Save/Open AtenaWin Session will store/restore the whole AtenaWin
session. It will deal with both FEModel related data as well as with the current state of your
postprocessing windows. Simply, it should put you to the point, where you previously left the
AtenaWin session.

The last option causes to remember/reset only graphical settings of a postprocessing window.
It does not remember, what actual data are plotted. It merely store/restore how and where are
they displayed. It can be used for a monitor window or for 2D/3D postprocessing window.
This option should be used in cases, when e.g. for a particular detail of the structure we need
to produce several results, like e.g. plot stress and plot strain (possibly at different execution
steps) . In order to produce such a set of results, first we set all draw properties for the first
window (from the serie) and execute Save Figure Settings. Whenever (in the future) we need
the same plot for another plot data, we have to restart AtenaWin, restore FEModel data and
then we have to open the previously store data settings, i.e do Open Figure Settings. After
that we have to specify, what data should be plotted just now.

Save Figure Settings, Open Figure Settings are available thru Menu->Application->Open
AtenaWin Session. (It is also possible to use Menu->File-> Open AtenaWin Session that
invoke the same dialog and subsequent open data action.

8.3. Creating a 2D plot of results for nodes located on a
border/cutting line(s)

In this section we will present a procedure, how to create 2D plots of an output data, (e.g.
stress o, etc.) along some path, (e.g. boundary of the structure, cutting lines...), at a particular

time, e.g. after execution of a particular step. Note that work with monitors is similar.
As an example, let us use the analysis defined in the input file
“...\Atena\Projects\DLLs\Examples\AtenaWin\test ex import.inp”

and produce a plot of vertical displacements along perimeter of the bottom at the 20th step,
see the figure below.
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These are the steps to do:
1/ Run AtenaWin.

2/ Open the file “AtenaWin\test ex import.inp”, execute the analysis and exit. The execution
will create archive files Consl.001, Consl.010, Consl.015 and Consl.020 with results from the
steps 1, 10, 15 and 20, see your working directory. The AtenaWin desktop should look
something like the Ist figure in Section 8.1.

3/ Run AtenaWin again and execute the file
“...\Atena\Projects\DLLs\Examples\AtenaWin\test_plot.inp”. Description of the content of
the input file is given later.

4/ Change standard draw properties as follows and redraw the "Geometry" window. Close the
dialog.
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4/ Press the "Monitor set 2" icon 2| to create the "Set 2: Graph x" window and activate it.

5/ Press the "Graph series" icon b |to open the "Graph series" dialog.
6/ Press the button "Add new series" to create a new plot series.

7/ In the dialog, from the combo box "Horizontal value" - "Name" choose "s-coord" entry and
from the combo box "Vertical value" - "Name" choose "z-disp. Doing that we are creating a
plot, whose horizontal and vertical values are output data MONITOR _SET 2 S COORD and
MONITOR _SET 2 Z DISP, (available in the OUPUT DATA location).

8/ Check the checkbox "Values' profile for fixed time" and for both "Horizontal" and
"Vertical" axis choose time "0.0000". This produces a plot for one time and many locations,
see the explanation in the Atena Input manual, description of MONITOR 1, MONITOR 2,
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PLOT 1 and PLOT 2 keywords of the OUTPUT command. If it were not checked, a
standard graph is produced, i.e. for many times and one location. Note that as these are data
created by "OUTPUT NAME "..."  PLOT x .. command, see the input file, they stored for
time=0.000, (unlike data created by "OUTPUT NAME "..." MONITOR _x that are available

for a time span).
9/ Change the "Series name" data to "Z displacements at the bottom".

9/ At this moment the dialog should looks like

Graph series

[ Add new zernes ] Fixed time
Select emsting seres Horizontal  0.000000 -
Seres d [ v [ Delete seies Veical  0.000000 -
Harizantal value Walues' profile for figed time
Mame z_coord -
[rata zarting
Yalue 1 Factor 4
@ Maone ) Horzantal () Yertical
Yertical value
Mame 2 disp -
Walue 1 Factor 1
Sernes name
Z dizplacements at the battam [ Cancel ] [ Apply ] [ Q.

L

Press the "OK" button to close the dialog and draw the plot.

10/ Press the Graph properties icon i to modify the graph as required. e.g. change the

graph's title, description of the axes etc. as follows:
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—
Press "Apply" and "Cancel" buttons to apply the changes and close the dialog.

11/ The resulting graph of the displacement should yield the 2nd figure in this Section.

Of course, any number of such 2D plots for a particular time can be specified in AtenaWin
and each of those plots can depict multiple series, (i.e. different results). The variety of such
graphs resembles that for ordinary monitor plots.

It remains to discuss the input file test plot.inp. It has been prepared to demonstrate all
typical steps you need to produce a 2D plot and each step is commented to ease its
understanding.

Although test.inp is prepared for "batch" execution, all its command can be input also
interactively. For example:

The previous analysis can be restored by "Menu->Application->Restore FE Model From"
command.

New macro nodes can be input. For example to input the macro node 301 at location of the FE
node 101 do the following:

e Activate the window with the geometry of the structure.

¢ Open the dialog "Menu->Input->FEM Generator->Macro Node.
e Open the dialog "Menu->Input->FEM Commands->Node.

¢ In the Macro node dialog, Node Id. field type 301.
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Click in the Node dialog. A message box appear to ask for confirmation on the new
macro node 301. Click "OK". Type 110 into Node Id. field of the Node dialog.
(Alternatively "Select" and "Grab" the node directly from the window with graphics
and a few mouse click).

Click "Export" button in the Node dialog. It exports the coordinates form node 110 to
macro node 301

Click "Apply" button of the Macro node dialog and confirm that the changes to the
macro node should be applied.

Optionally, press |, location Macro Nodes, output data
MACRO NODAL COORDINATES to print all macro nodes and check data for the
new macro node 301.

Some input commands have not yet a proper dialog. However, these command can be typed

directly into "Menu->Input->Command line.
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It is often useful to inspect nodes, e

Time
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lements and other data entities. All that is available thru

"Menu->Input" command. For example, we want to see location of all nodes in the selection
"border nodes". (Of course, we must do it after executing the file "test plot.inp".) :



e Open the dialog "Menu->FEN Commands->List

e In the List name field either type or select the list called "border nodes".
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e Press "Select" or "Show" button and the window with graphics will mark all the nodes

in the chosen selection.
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All monitor/plot series can be printed. For example, if we want to print the serie "s_coord", do

the following:

e Press "Menu->Output->Data Request and choose location OUTPUT DATA.

e Press "Filter" button and press Monitor set(s) 2 button "Add" to filter only data sets for
the Monitor/Plot 2. Press "OK" to close the dialog for filtering.

e Select "MONITER SET 2 S COORD" and press "Apply". The serie "s_coord" will

be printed into a window with Atena's *.out file.

e Any selection can be printed similarly. The only difference is that a proper filter must

be used.

If you want to define a serie interactively, e.g. the serie "s_coord", use the command "Menu-
>Qutput->Monitor request, choose appropriate output type, e.g. "Plot 2 immediate", type
Output name, e.g. "s_coord", press the button "Next" and using the next property pages define

a required output, see Section 6.

Listing of the file test.plot.inp.

/*

Example for how to create 2D plot of vertical displacement for

test ex import.inp
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*/

//

along its bottom boundary

Restore the results from

".\Atena\Projects\DLLs\Examples\AtenaWin\test ex import.inp".

//
//

//
//

Results from the 20th step has been saved to file ConsI.020
(within your working directory).

RESTORE FROM "ConsI.020" ;

Define a boundary curve at the bottom.

Firstly, define a macro joints at each corner of the bottom boundary.
MACRO_JOINT COORDINATES
301 1.20 1.70 .30
302 .20 -0.20 .30
303 .00 -0.20 .30
304 .00 0.20 .30
305 .80 0.20 .30

306 .80 1.70 .30

’

of
of
of
of
of
of

node 110
node 30
node 7
node 5
node 20
node 112

location
location
location
location
location
location

at
at
at
at
at
at

OO oo

Secondly, generate selections containing nodes near the border,
i.e. for each border line

pick all nodes located close to it, (i.e.
of appropriate macro nodes defined above)
and add them in the selection, thus creating a polygon of the border
nodes, where vertical displacements are to be plotted.

FE nodes close to connection

SELECTION "nodes 110 30" GENERATE NODES WITHIN DISTANCE 0.01 FROM LINE

MACRO NODES 301 302 INSIDE
SELECTION "nodes 30 7"
MACRO NODES 302 303 INSIDE
SELECTION "nodes 7 5"
MACRO NODES 303 304 INSIDE
SELECTION "nodes 5 20"
MACRO NODES 304 305 INSIDE
SELECTION "nodes 20 112"
MACRO NODES 305 306 INSIDE
SELECTION "nodes 112 110
MACRO NODES 306 301 INSIDE

//
//
//
//
//

Sort the selections.

executed beforehand, see

SELECTION
SELECTION
SELECTION
SELECTION
SELECTION
SELECTION

"nodes 110 30"
"nodes_30_ 7"
"nodes 7 5"
"nodes 5 20"
"nodes 20 112"
"nodes 112 110

near the joining.

(from all boundary line)
on the boundary.

EXECUTE
GENERATE
EXECUTE
GENERATE
EXECUTE
GENERATE
EXECUTE
GENERATE
EXECUTE
" GENERATE
EXECUTE

Note that the selections'

// line between nodes
NODES WITHIN DISTANCE O.
// line between nodes
NODES WITHIN DISTANCE O.
// line between nodes
NODES WITHIN DISTANCE O.
// line between nodes
NODES WITHIN DISTANCE O.
// line between nodes
NODES WITHIN DISTANCE O.
// line between nodes

"EXECUTE in the above lines.

GENERATE
GENERATE
GENERATE
GENERATE
GENERATE
" GENERATE

SORT
SORT
SORT
SORT
SORT
SORT

between
between
between
between
between
between

line
line
line
line
line
line

110,30
01 FROM
30,7

01 FROM
7,5

01 FROM
5,20

01 FROM
20,112
01 FROM
112,110

generation must be

Sorting direction must correspond with orientation and direction of
the boundary and it can be something like
SORT +X +Y +Z or SORT +X -Y

nodes
nodes
nodes
nodes
nodes
nodes

Connect the above individual selections and remove excessive nodes
It will constitute a selection "border nodes" that
contains list of FE nodes along the whole bottom boundary,

, enlisted in order of their appearance

LINE

LINE

LINE

LINE

LINE

110,30
30,7

7y
Sy
20,112
112,110

5
20
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SELECTION "border nodes" INSERT "nodes 5 20"
SELECTION "border nodes" CONNECT "nodes 20 112"
SELECTION "border nodes" CONNECT "nodes 112 110"
SELECTION "border nodes" CONNECT "nodes 110 30"
SELECTION "border nodes" CONNECT "nodes 30 7"
SELECTION "border nodes" CONNECT "nodes 7 5"

// Generate series, which constitute horizontal and vertical values of
// the constructed 2D plot, (i.e. Z displacement along the bottom
// boundary) .

// They are respectively called "s coord", (=nodal distance from the 1lst
// node, i.e. node 5, of the border along the boundary)
// and "z disp", (= displacement, item 3).

OUTPUT NAME "s coord" PLOT 2 LOCATION NODES NODE AT SELECTION
"border nodes" DATA LIST "REFERENCE BORDER COORDINATE" END ITEM FROM 1 TO 1

’

OUTPUT NAME "z disp" PLOT 2 LOCATION NODES NODE AT SELECTION
"border nodes" DATA LIST "DISPLACEMENTS" END ITEM FROM 1 TO 1

’

// Done. Use the GUI of AtenaWin to display window with the plot.

9. SAMPLE ANALYSIS

This section serves as an example of a 3D AtenaWin execution, which presents an analysis of
a symmetric half a RC beam subject to vertical loading. Description of the model is available
as a comment in the ATENA.INP input file. Please refer to ATENA Input File Format to
understand all commands in this file.

In the following all steps to carry out the analysis are reviewed.
1/ AtenaWin installation:

The first step to use AtenaWin is to install ATENA software from the ATENA installation
CD. It will install all needed dynamically linked libraries, including their registration as well
as AtenaConsole.exe and AtenaWin executables.

2/ Working directory:

Create a directory, where the analysis is to be carried out. This is achieved for example by MS
Windows explorer. Open this directory, i.e. it becomes your actual working directory.

3/ Input file:

Start the AtenaWin program. If the ATENA software directory is in the system PATH string,
simply type

AtenaWin /M module name

otherwise use filename with fully qualified path, e.g.

“c:\program files\cervenka\AtenaWin” /M module_name

In the above, module name is name of the module you need to execute. Typically it is
CCStructures, however, for creep structural analysis the module CCStructuresCreep must be
used etc.
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AtenaWin will start. The AtenaWin desktop, (see the figure below) will popup four windows,
each of them dedicated for viewing and editing one of the four main ATENA I/O streams,
(i.e. *.inp, *.out, *.msg and *.err file) and two windows for graphics.
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Figure 30 AtenaWin initial desktop

Click on ATENAL.INP file and input all commands to describe the analysis. For this sample
analysis, simply paste in this file the following listing:

Listing of input file ATENA.INP

// Testing input data format

TASK name "Creep test vs. laboratory experiment"
title "Test input file"
dimension 2

/*
test speciment: h/w/1 = 30.16/0.3/3 m
reinforcement ratioo 0.6%
concrete B 30
steel

*/

// Material definition for concrete

MATERIAL ID 1 NAME "M4 kalibrace" TYPE "CCSBETAMaterial"

E 36950.
Mu 0.20
Ft 3.257

Fc -42.50



ISOFT 1.0

Gf 8.143E-05

Eps C -2.301E-03
CompRed 0.800
CSOFT 1.0

Wd -5.0000E-04
Shear Variable

CS 0.6

// Material definition for reinforcement

FUNCTION ID 2

NAME

"Function for Reinforcement"
TYPE

"CCMultilLinearFunction"
xvalues 0. 0.0019 1.
yvalues 0. 400. 400.

MATERIAL ID 2

NAME

"Steel"

TYPE
"CCReinforcement"

E 210000 FUNCTION 2

// Geometry definition for concrete
GEOMETRY id 1 name "Concrete" type "2D"

// Geometry definition for reinforcement

GEOMETRY id 2 name "Concrete" type "Truss"

// Element type definition for concrete

thickness 0.3

area 0.0002888

ELEMENT TYPE ID 1 NAME "Iso-quads" TYPE "CCIsoQuad<xxxx>" LINEAR
ELEMENT TYPE ID 10 NAME "Iso-quads" TYPE "CCIsoTriangle<xxx>" LINEAR

// Element type definition for concrete

ELEMENT TYPE ID 2 NAME "Iso-trusses" TYPE

// Element group definition for concrete

"CCIsoTruss<xx>" LINEAR

ELEMENT GROUP ID 1 TYPE 1 MATERIAL 1 GEOMETRY 1
ELEMENT GROUP ID 10 TYPE 10 MATERIAL 1 GEOMETRY 1

// Element group definition for reinforcement

ELEMENT GROUP ID 2 TYPE 2 MATERIAL 2 GEOMETRY 2

// Generate concrete elements (using T3D generator)

T3D_ GENERATE "-d 0.4"

vertex 1 xyz 0 0.00 O
vertex 2 xyz 3 0.00 O
vertex 3 xyz 3 0.16 0

65
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vertex 4 xyz 0 0.16 O

curve 1 vertex 1 2 count 74
curve 2 vertex 2 3 count 8
curve 3 vertex 3 4 count 74
curve 4 vertex 4 1 count 8

patch 1 normal 0 0 1 boundary curve 1 2 3 4 quad map yes size def elemgroup

10 1
T3D_END
// Generate reinforcement bar elements (using CCFEModelGenerate)

//Coordinate definition. Suma= 15
MACROiJOINT COORDINATES

100 0.02 0.015

101 2.98 0.015

//REINFORCEMENT GENERATE BAR 1001 THROUGH NODES 100 101 NAME "Bottom
reinforcement" MINIMUM 0. GROUP 2 EMBEDDED AT 1
MACRO ELEMENT 1001 GENERATE TYPE "CCDiscreteReinforcementME"
THROUGH NODES 100 101 NAME "Bottom reinforcement" MINIMUM O.
GROUP 2 EMBEDDED AT 1
ELEMPROP "Bar_l"
NODEPROP "N1" ID 1
NODEPROP "N2" ID 2

// Load case 1 definition

LOAD CASE ID 1 NAME "Supports"
SUPPORT SIMPLE node 1 dof 1 value 0.0
SUPPORT SIMPLE node 1 dof 2 wvalue 0.0
SUPPORT SIMPLE node 2 dof 2 wvalue 0.0

// Load case 2 definition
LOAD CASE ID 2 NAME "Loads"
SUPPORT SIMPLE node 121 dof 2 value -1.5 // displ. control

// Set analysis options/switches
SET Static

SET Iteration Limit 30

//SET Newton-Raphson

SET Displacement error 0.01

SET Residual error 0.01

SET Optimize Band Width Sloan
SET TANGENT PREDICTOR

SET Line-Search

LINE SEARCH WITH ITERATIONS

UNBALANCED ENERGY LIMIT 0.800
LINE SEARCH ITERATION LIMIT 20
MINIMUM ETA 0.001
MAXIMUM ETA 1.000

// Request nodal output

OUTPUT NAME "Displ." MONITOR EACH ITERATION LOCATION NODES
RECORD NODE AT 121 DATA LIST "DISPLACEMENTS" ITEM AT 2 END
OUTPUT NAME "React." MONITOR EACH ITERATION LOCATION NODES

TRACK NODE AT 121 DATA LIST "PARTIAL REACTIONS" ITEM AT 2 END
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STEP ID 1 STATIC NAME "Step 1" LOAD CASE 1 * 1.0 2 * 0.001 EXECUTE
OUTPUT LOCATION ELEMENT IPS DATA LIST "STRESS" "ENGINEERING STRAIN" END

/* End of File */

//OUTPUT LOCATION OUTPUT DATA DATA LIST "MONITOR SET Displ." END
//OUTPUT LOCATION OUTPUT DATA DATA LIST "MONITOR SET React." END
OUTPUT LOCATION OUTPUT DATA DATA ALL

Of course, it is also possible to open a file and to say AtenaWin that it should be treated as
one of the AtenaWin I/O streams. The simplest way to achieve it is to catch the file from a file

explorer and drag it atop of the AtenaWin desktop. Then press one of icons, to
make the file one of the I/O streams, ( *.inp, *.out, *.msg or *.err, icons arranged in vertical
order).

4/ Execution:

Start execution of the analysis by depressing the exection icon . The analysis gets started
and the status bar at the bottom of the AtenaWin desktop continuously reports the analysis
status. When it shows “Analysis completed”, postprocessing phase can start.

The analysis can be at any time terminated. For more information see the “Application”
menu.

5/ Postprocessing:

By default, by this time you should have one opened postprocessing window. Set focus to this
window, (Alternatively, press the icon E to open another AtenaWin postprocessing

window. Thereafter, depress the icon & and choose, what output data you want to see. For
example, choose “Displacements” and select the item X(2) to see vertical displacement. A
figure like the one below should appear:
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Figure 31 AtenaWin 3D postprocessing

There are several options to customize view and scale, in which the output results are drawn.
All of these commands are described in the previous chapters of this document. Any number
the above postprocessing windows can be opened simultaneously. If they are opened already
during the analysis, they can be automatically updated with the most recent results.

5/ 2D plots:

Two dimensional plots are available after pressing the icon = e (for the monitor 1 and plot 1),

or the icon ==_ ke (for the monitor 2 and plot 2). The actual plot to be drawn is specified by

pressing the icon B . It will open a new dialog box. Press “New” button to define a new
series to be plotted. From the “Name” combo box choose an output to be plotted on the
horizontal axis, e.g. “Time”. Do the same for the vertical axis, e.g. “RightCornerDeflection”.
As the deflections are negative, set Factor (for the vertical axis) equal to —1. Press “OK” to
draw the plot. Each of the 2D plots can draw any number of output data series and any
number of the windows with 2D plots can be opened and watched simultaneously. They can
also be updated at run-time already during analysis. There are many options available to
customize your 2D plots. For more information refer to the previous sections of this
document.

6/ Restarting and continuing the analysis

be carried out. To achieve this, press the icon ™. and the analysis continue from the place of
the most recent break point. Alternatively, put the cursor at the end of the input file and type
in all new command. Then, place the cursor at the first added line and press Ctrl+Shift+F. The
execution will start the same way it has not been interrupted from the indicated line.

An analysis is restarted after some changes having been done in the ATENA input file. The
current model is deleted and the analysis starts from scratch processing all the commands in
the ATENA input file (starting from the 1*' line).
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